HARCOURT
== BRACE

MILLER

A Proceures

Electromc Workpapers antt Referelwe Guiﬁe

_- ; =

';% IHJ

on b |

Audit Programs

ngagement Letters
orms and Checklists
\uditor's Reports

overnment Documents



MILLER

Harcourt Brace
Professional Publishing

A Division of
Harcourt Brace & Compzny

San Diego
New York
London

George Georgiades
August 1996




This publication is designed to provide accurate and authoritative
information in regard to the subject matter covered. It is sold with the
understanding that the publisher is not engaged in rendering legal,
accounting, or other professional service.

The publisher has not sought nor obtained approval of this publication from
any other organization, profit or nonprofit, and is solely responsible for its
contents.

Copyright © 1996 by Harcourt Brace & Company

All rights reserved. No part of this publication may be reproduced or
transmitted in any form or by any means, electronic or mechanical, includ-
ing photocopy, recording, or any information storage and retrieval system,
without permission in writing from the publisher.

Permission is hereby granted to reproduce the Checklists, Workpapers,
Practice Aids, Sample Letters in this publication in complete pages, with the
copyright notice, for professional use and not for resale.

Portions of this work were published in previous editions.

HARCOURT BRACE and quill is a registered trademark of Harcourt Brace
and Company.

Printed in the United States of America

ISBN: 0-15-606449-9



ABOUT THE ACCOMPANYING DISKS

SYSTEM REQUIREMENTS

+ IBM PC or compatible computer
+ WordPerfect® 5.1 for MS-DOS™, Microsoft Word® 6.0 for Win-
dows™, or compatible word processor

+ 3 MB available on hard disk
+ Disk drive capable of reading 3.5” high-density disks.
* Laser or ink jet printer

INTRODUCTION AND INSTALLATION

Introduction

The disks provided with your Miller Audit Procedures Guide contains elec-
tronic versions of the model audit program, sample letters, practice aids,
checklists, and sample reports, plus a stand-alone Automated Workpapers
program, which can be used to produce more than 35 of the most common
audit workpapers. The book and disks together contain all the material
necessary to automate and perform a complete audit engagement.

The Automated Workpapers program contains all of the most common
audit workpapers from Cash to Income Taxes. The system is completely
menu driven so that even the computer novice can easily navigate through
the various workpapers, enter data, and review all calculations. The menu
system will automatically print the workpapers with portrait and land-
scape orientations and perform other utility functions. The electronic
practice aids are intended to be used in conjunction with your word
processing software. The electronic practice aids have been formatted in
Word 6.0 for Windows and WordPerfect 5.1 for DOS versions. If you do
not own either of these programs, your word processing software may be
able to convert the documents into a usable format. Check the user’s
manual that accompanies your word processing software for more infor-
mation about the conversion of documents.

Subject to the conditions in the license agreement and the limited
warranty printed on the disk envelope, you may duplicate the files on this
disk, modify them as necessary, and create your own customized versions.
Opening the disk envelope and/or using the disk in any way indicates
that you accept the terms of the licensing agreement.
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About the Accompanying Disks

If you experience any difficulties while running the Automated
Workpapers program or editing the electronic practice aids and cannot
resolve the problem using the information presented in this manual, fill
out the Software Support Form and fax it to (800) 874-6418. A technical
support representative will contact you with assistance.

Installation

To install the Automated Workpapers program and electronic practice
aids, insert either disk in your floppy drive (e.g., A:). Select the File, Run
command from the Windows Program manager, then type A:INSTALL in
the command line. If you are running this program outside of Windows,
type A:INSTALL from the DOS prompt. You will then be prompted to
specify the drive where you would like the files installed (e.g., C:). The
installation program will automatically create a subdirectory for you
entitled “/APG96,” where it will place all of the necessary files. The
installation will not affect previous versions of Miller Audit Procedures
software loaded on your computer. Please note that each disk contains a
separate installation program; therefore, you will need to install each disk
separately.

AUTOMATED WORKPAPERS

Creating New Files

Use the Newfile Utility to create a copy of the master program file. To load
the Newfile Utility from DOS, first type CD\APG96 to change to the
Miller Audit Procedures Guide directory and strike ENTER. Type Newfile
and strike ENTER to load the Newfile Utility program.

Once the Newfile Utility is loaded, you will be prompted to type a file
name of eight of fewer characters. Please note that the filename should not
include a three-letter extension. Type the filename and strike ENTER to
create a new file.

Note: If you enter the name of a file that already exists, the program
will not automatically overwrite the existing file. You will be
prompted to overwrite the existing file or not. Be careful; if you
answer yes, the existing file will be overwritten with a new blank
file.

When you create a new file for the Automated Workpapers program, two
files arc actually created. These files are simply copies of the master files,
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APG.WKM and APG.OVR. Both will have the file prefix that you entered
in the last step, but one will have a.WKB extension and the other will have
an .OVR extension. The extensions are added to the new files automati-
cally.

T};w .WKB file contains all input data, and the .OVR file contains all of
the hidden formulas, macros, and other code. Because these two files must
be present to run the program, they are referred to collectively as a program
file.

Retrieving a File (Running the Program)

To retrieve a file that you have created, first type CD\ APG96 from the DOS
prompt and strike ENTER to change to the Miller Audit Procedures Guide
directory . From the Miller Audit Procedures Guide directory, type RUN
Filename, where Filename is the name of the file created. From within
Windows, select the File, Run command from the Windows Program
Manager and type RUN Filename in the command line, where Filename is
the name of the file created.

Wait until the file is completely loaded before striking any keys. The
Main Menu will appear in the middle of the screen once the file is com-
pletely loaded. Use the arrow keys to highlight the menu option of your
choice and strike ENTER to execute the option or simply type the first
character of a menu option. Some menu options will take you to a submenu;
from a submenu you can either select another option or press ESC to
return to the prior menu.

Entering Data

If you are in a Data Entry screen, use the arrow keys to position the cursor
on each unprotected cell. Unprotected cells are displayed in a different
color or brightness than the protected cells. Input the requested label or
number, strike ENTER, and move on to the input cell. Strike ESC from any
Data Entry screen to return to the menu.

You cannot edit protected cells while in the Data Entry Mode (i.e., when
the program menu is active). See “CTRL+C Mode” section to learn how to
break out of the program menu to edit protected cells.

To access the first submenu, select Workpaper Information from the
Main Menu. Then select General Audit Information to access the first
input screen. The information you input in this screen will be used as the
heading of each workpaper. If you make a mistake while inputting infor-
mation, press the F2 function key to edit the cell contents.

AUDIT PROCEDURES / ix



About the Accompanying Disks

As you type the first character of the date in the Financial Statement
Date input cell, you will see / / in the top left corner of the screen. These
slashes, which appear automatically, divide the month, day, and year in
each location where a date input is required.

The Workpaper Reference column contains the default references that
are transferred to the respective workpapers. These default references are
based on the indexing scheme proposed in the Miller Audit Procedures
Guide. If you prefer, you can edit the workpaper references to reflect your
own indexing format.

Numbers need to be entered in a specific way. For example, enter dollar
amounts without commas (e.g., type 1000 and “$1,000” will appear in the
cell.) Enter percentages as the decimal equivalent. For example, type .09
and “9%" will appear in the cell. Omit commas from decimal number
inputs. For example, in a cell requiring a decimal input, type 1000.99, and
“1,000.99” will appear in the cell.

Strike ESC to return to the menu, then select Financial Statement Infor-
mation. The data requested in the Financial Statement Information screen
is used for the calculations in the various Analytical Procedures workpapers.
After completing these two screens, strike ESC to return to the menu and
ESC again to return to the Main Menu.

From the Main Menu, select Audit Workpapers to access the submenu
that controls all of the workpaper groups. If you select a workpaper group,
menu options for all of the workpapers contained in that group will
appear. Select one of the workpaper menu options to view the actual
workpaper and to enter data. Strike ESC to return to the menu.

CTRL+C Mode

Striking the “CTRL” and “C” keys at the same time will take you out of the
Data Entry Mode. In the CTRL+C mode, the program menu is inactive,
you can move freely through the program, edit protected cells, and access
the secondary menu.

Use the F5 function key to go to a specified cell address.

To edit workpaper titles in the CTRL+ C mode, you must strike / to
activate the secondary menu, then select Worksheet, Titles, Clear.

Strike ALT+A to reactivate the program menu.
Printing the Workpapers
To print a workpaper, select Print Workpapers from the Main Menu. Next,

select Toggle Workpapers To Print to access the screen where you can
determine which workpapers to print. To mark a workpaper to print, use
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the vertical arrow keys highlight the title of the workpaper you would like
to print and type 1 in the input box next to the title. Repeat this process
until all the workpapers you would like to print are marked with “1.”
Select Print Toggled Workpapers and Yes, to print all workpapers that are
toggled to “1”. To print all of the workpapers, enter a 1 next to Print All
Workpapers. For most workpapers, only rows in which you have entered
data will be displayed when you print.

Workpapers shown with an “*” are set to print with a landscape
orientation. For this to work properly, you must choose Select Printer
from the Print Workpapers menu. Select the Laser or the Ink Jet printer
options. You must print the workpapers on a laser or other printer with
graphic capabilities because dot matrix printers are not capable of land-
scape (graphic) printing without external software.

Please note that if you receive an error message when printing the
program will fall out of Data Entry Mode and the program menu will
become inactive. Strike ESC to clear the printer error then Alt+A to
reactivate the program menu. Contact Technical Support if you are prob-
lems persist.

Program Utilities

From the Main Menu, select Utilities to access the submenu controlling the
Column and Row Display and Automatic/Manual Recalculation functions.

Column & Row Display

From the Column & Row Display feature you can choose to either Display
Borders or Remove Borders from the workpapers by selecting the associ-
ated option. Displaying the borders will show the column letters across
the top and the row numbers down the left side of the screen. Displaying
the borders is useful when performing manual operations in the CTRL+C
mode on a specified cell or range of cells. See the section entitled “CTRL+C
Mode” for an explanation of manual operations.

Automatic/Manual Recalculation

Select Automatic/Manual Recalculation to run the program in either one
of these modes. The default setting is Automatic Recalculation, which
means that all formula results are updated immediately after each input.
If the program seems sluggish while entering data, use the Manual Recal-
culation option, and the results of formulas will be updated only when
you return to the menu.
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Save & Exit

Select Save & Exit from the Main Menu to save any changes to the current
file and to exit the program. First, you must select Save Program Data and

Yes to save your data.
Then, select Exit Program to exit the program and return to your
operating system. Be sure to save your file before using Quit or Exit.

Workpaper Listing

Each Audit Workpapers submenu option is listed below, with the indi-
vidual workpapers contained under that submenu option.

Cash & Marketable Securities Workpapers

Bank Reconciliation AA-1(a—e)
Proof of Cash AA-2(a—e)
Bank Transfer Schedule AA-3
Count Sheet of Securities AB-1
Investment in Securities Analysis AB-2

Accounts & Notes Receivable Workpapers

A/R Confirmation Control Summary AD-1
A/R Confirmation Results Summary AD-2
A/R Analytical Procedures AD-3
A/R Rollforward from Confirmation Date to Balance

Sheet Date AD-4
A /R Reconciliation to General Ledger AD-5
A/R Alternative Procedures & Review for Uncollectible

Accounts AD-6
A/R Allowance for Uncollectible Accounts AD-7
Notes Receivable Analysis AE-1

Inventory Workpapers
Inventory Test Count Sheet AG-1
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Inventory Reconciliation—Physical to Balance Sheet Date AG-2
Inventory Price Test—Purchased Goods AG-3
Receiving Cutoff AG-4
Shipping Cutoff AG-5
Inventory—Analytical Procedures AG-6

Property, Plant, & Equipment Workpapers

Property, Plant, & Equipment—Summary Analysis AJ-1
Property, Plant, & Equipment—Analytical Procedures AJ-2
Property Additions AJ-3
Property Deletions Al-4

Prepaids & Accruals Workpapers

Prepaid Insurance AH-1
Prepaid & Accrued Property Taxes AH-2
Other Prepaid Expenses AH-3
Accrued Liabilities—Analytical Procedures LD-1
A /P, Notes Payable, & Long-Term Debt Workpapers

Accounts Payable Confirmation Results LA-1
Accounts Payable & Purchases—Analytical Procedures LA-2
Debt Obligations & Interest Analysis LB-3
Debt Obligations & Interest—Analytical Procedures LG-1

Income Taxes Workpapers

Analysis of Accrued/Refundable Income Taxes LE-1
Deferred Income Taxes LE-2
Summary of Carryforwards and Expiration Dates LE-3

Equity, Revenue, Expense, & Misc. Workpapers

Carryforward Stock Book Analysis EA-1
Analysis of Equity Accounts EA-2
Revenue & Expense—Analytical Procedures 0OC-1
Analysis of Legal Fees OE-1
Analysis of Unrecorded Audit Differences G-7

AUDIT PROCEDURES / xiii



About the Accompanying Disks

ELECTRONIC PRACTICE AIDS

Opening the Files

1. Open your word processing program.

2. If you are using Microsoft Word, choose Open from the File menu.
Select the subdirectory that contains the loaded files to list the names
of the files.

3. From WordPerfect, press CTRL + F5 to list subdirectories. Select the
subdirectory that contains the loaded files. Press ENTER to display a
list of files on the disk.

4. Refer to the Disk Contents to find the filename of the document you
want to use. The Disk Contents is also available on your disk in a file
called “TOC.” You can open this file and view it on your screen or
print a hard copy to use for reference.

5. Highlight the name of the file you want to use and double-click your
left mouse button to open the document in Microsoft Word. If you
are using WordPerfect, highlight the name of the file and press 1 to
retrieve the document. You can now modify and/or print this file.

Word Processing Tips

Wherever possible, the text of the documents has been converted to tables
so that you can modify the text without altering the format of the docu-
ments. To maneuver within a table, press TAB to move to the next cell, and
SHIFT + TAB to move backward one cell. If you want to move to a tab stop
within a cell, press CTRL + TAB. For additional tips on working with
tables, consult your word processor’s manual. It might be helpful to turn
on the invisible table lines in Microsoft Word while modifying the docu-
ment by selecting Gridlines from the Table menu. In WordPerfect, press
F11 to reveal all formatting codes at the bottom of the screen; this will help
you determine the shape of the table. Additional table options can be
found in WordPerfect under the Columns/Tables function ALT + F7.

Microsoft Word and WordPerfect are equipped with search capabili-
ties to help you locate specific words or phrases within a document. The
Find option listed under the Edit menu performs a search in Microsoft
Word. If you are using WordPerfect, press SHIFT + F2 (Search) to locate
key words.

Important: When you are finished using a file you will be asked to save
it. If you have modified the file, you may want to save the modified file
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under a different name rather than the name of the original file. (Your
word processing program will prompt you for a file name.) This will
enable you to reuse the original file without your modifications. If you
want to replace the original file with your modified file, save but do not
change the name of the file.

Print Troubleshooting

If you are having difficulty printing your document in Microsoft Word or
WordPerfect, the following suggestions may correct the problem.

Microsoft Word

Select Print from the Microsoft Word File menu. Then choose the
Printer function.

Ensure that the correct printer is selected.
From this window, choose Options.

In the media box, make sure that the paper size is correct and that the
proper paper tray is selected.

Check your network connections if applicable.

If you still have trouble printing successfully, it may be because your
printer does not recognize the font Times New Roman. At this point,
you should change the font of the document to your default font by
selecting the document CTRL + A and then choosing Font from the
Format menu and highlighting the name of the font you normally
use. Changing the font of the document may require additional
adjustments to the document format, such as margins, tab stops, and
table cell height and width. Select Page Layout from the View menu
to view the appearance of the pages before you try to print again.

WordPerfect

Use Format, Page (SHIFT + F8, 2) to check your paper size. [f 8.5x 11”
Standard is not selected, press 7 to correct it.

If the paper size is correct, investigate all the different Print Options
(SHIFT + F7) available to you:

7: Initialize Printer After pressing 7. you will receive the following prompt:
“Proceed with Printer Initialization?”” Choose Y for yes.
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: Select Printer Make sure the correct printer is selected. If not, position

the cursor to highlight the appropriate printer and press 1 to select it.

: Print Full Document Try printing the document again. Immediately

afterward, choose SHIFT + F7, 4 to check the status of your print job. If
an error message is displayed, consult your WordPerfect and printer
manuals.

+ If no current print job is showing, try the following additional Print
options found in the Select Printer, Edit menu (SHIFT + F7,S, 3):

1:

Name Verify that the correct printer is selected.

2: Port Verify that the correct printer port is selected.
3:

Feeder If you have a printer that requires a manual page feed,
select it here.

: Cartridges/Fonts/Print Wheels You may find that you have ac-

cess to additional fonts here, especially soft fonts. Note that if soft
fonts are marked with an asterisk (*), you will have to choose
Initialize Printer (SHIFT + F7, 7) every time you print for them to
be downloaded.

: Initial Base Font You may be having difficulty because your

printer is not compatible with CG Times. You can correct this
problem by changing the base font of the document to your
default font. Simply highlight the name of your default font and
press ENTER. If you don’t know what your default font is, try
Courier 10cpi. Use the Print Preview function (SHIFT + F7, 6) to
determine whether you need to make adjustments to the format-
ting of the document because of the font change.

Electronic Practice Aid Listing

Section [—Audit Programs

Audit Program—~Preliminary and General Audit

Procedures AP_PRELM
Audit Program—Substantive Tests AP_SUB
Audit Program—Tests of Controls AP_TESTS

Section [I—Correspondence and Confirmation Letters
lustrative Audit Engagement Letter CORRES01
[Nlustrative Letter of Representations CORRES02
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under a different name rather than the name of the original file. (Your
word processing program will prompt you for a file name.) This will
enable you to reuse the original file without your modifications. If you
want to replace the original file with your modified file, save but do not
change the name of the file.

Print Troubleshooting

If you are having difficulty printing your document in Microsoft Word or
WordPerfect, the following suggestions may correct the problem.

Microsoft Word

Select Print from the Microsoft Word File menu. Then choose the
Printer function.

Ensure that the correct printer is selected.
From this window, choose Options.

In the media box, make sure that the paper size is correct and that the
proper paper tray is selected.

Check your network connections if applicable.

If you still have trouble printing successfully, it may be because your
printer does not recognize the font Times New Roman. At this point,
you should change the font of the document to your default font by
selecting the document CTRL + A and then choosing Font from the
Format menu and highlighting the name of the font you normally
use. Changing the font of the document may require additional
adjustments to the document format, such as margins, tab stops, and
table cell height and width. Select Page Layout from the View menu
to view the appearance of the pages before you try to print again.

WordPerfect

Use Format, Page (SHIFT + F8, 2) to check your paper size. [f 8.5x 11”7
Standard is not selected, press 7 to correct it.

If the paper size is correct, investigate all the different Print Options
(SHIFT+ F7) available to you:

7: Initialize Printer After pressing 7, you will receive the following prompt:
“Proceed with Printer Initialization?” Choose Y for yes.

AUDIT PROCEDURES / xv



About the Accompanying Disks

Request for Cutoff Bank Statement

Standard Form to Confirm Account Balance Information
with Financial Institutions

Request for Confirmation of Securities Held by Brokers
or Other Third Parties When Listing of Securities Is
Included in the Confirmation Request

Request for Confirmation of Securities Held by Brokers
or Other Third Parties When Listing of Securities Is
Not Included in the Confirmation Request

Request for Confirmation of Accounts Receivable—
Positive Request

Request for Confirmation of Accounts Receivable—
Negative Request

Request for Confirmation of Notes Receivable

Request for Confirmation of Inventories Held by
Warehouses or Other Third Parties When Listing of
Inventories Is Provided by the Client and Enclosed
with the Confirmation Request

Request for Confirmation of Inventories Held by
Warehouses or Other Third Parties When Listing of
Inventories Is Not Provided by the Client and Not
Enclosed with the Confirmation Request

Standard Confirmation Inquiry for Life Insurance
Policies

Request for Confirmation of Insurance Policies Other
Than Life Insurance

Request for Confirmation of Accounts Payable
Request for Confirmation of Notes Payable

Request for Confirmation of Mortgage Debt

Request for Confirmation of Lines of Credit

Request for Confirmation of Contingent Liabilities
Request for Confirmation of Compensating Balances
Request for Confirmation of Lease Agreement

Request for Confirmation of Capital Stock—Transfer
Agent or Registrar

Request for Confirmation of Defined Benefit Pension
Plan Actuarial Information—FASB Statement No. 87

CORRESO03

CORRES04

CORRES05

CORRES06

CORRES07

CORRES08
CORRES09

CORRES10

CORRES11

CORRES12

CORRES13
CORRES14
CORRESI15
CORRES16
CORRES17
CORRES18
CORRES19
CORRES20

CORRES21

CORRES22
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Request for Confirmation of Postretirement Health Care
Benefits Actuarial Information—FASB Statement

No. 106 CORRES23
Mustrative Audit Inquiry Letter to Client Legal Counsel
if Management Has Provided Details of Legal Actions CORRES24

[lustrative Audit Inquiry Letter to Client Legal Counsel
if Management Has Not Provided Details of Legal
Actions CORRES25

Communication to the Client of Reportable Conditions—

Report Does Not Include a Statement about Whether

Any of the Reportable Conditions Identified Are

Material Weaknesses CORRES26

Communication to the Client of Reportable Conditions—

Report Includes a Statement That None of the

Reportable Conditions Identified Are Material

Weaknesses CORRES27

Communication to the Client of Reportable Conditions—

Report Includes a Statement That Some of the

Reportable Conditions Identified Are Material

Weaknesses CORRES28

Report on Material Weaknesses Separate from Report on
Reportable Conditions—Nonexistence Of Material
Weaknesses CORRES29

Report on Material Weaknesses Separate from Report on
Reportable Conditions—Material Weaknesses
Identified CORRES30

Section [lI—Practice Aids, Forms, and Checklists

Client Acceptance and Retention Evaluation Form FORMSO01
Workpaper Organization and Indexing FORMS02
Audit Planning Questionnaire FORMSO03
Audit Time Budget and Control FORMS04
Individual Time Accumulation Sheet FORMSO05
Inherent Risk Assessment Form—Account Balance or

Transaction Class Level FORMSO06
Planning Materiality Calculation Form FORMS07
Internal Control Structure Questionnaire FORMSO08
Audit Sampling Worksheet for Substantive Tests FORMS09

xviii AUDIT PROCEDURES



About the Accompanying Disks

Audit Sampling Worksheet for Tests of Controls FORMS10
Analytical Procedures—Ratio Analysis Form FORMS11
Inventory Observation Checklist FORMS12
Audit Review and Approval Checklist FORMS13
Tax Review Checklist FORMS14
Differences of Professional Opinion Form FORMS15
Financial Statement Disclosure Checklist FORMS16

Section V—Auditor’s Reports
Standard Unqualified Report—Single Year Financial

Statements REPORTO1
Standard Unqualified Report—Comparative Financial
Statements REPORTO02

Successor Auditor’s Unqualified Opinion When
Predecessor Auditor’s Report Is Unqualified and Is
Not Presented REPORTO03

Successor Auditor’s Unqualified Opinion When
Predecessor Auditor’s Report Included an
Explanatory Paragraph and Is Not Presented REPORTO04

Successor Auditor’s Unqualified Opinion When Prior-Year

Financial Statements Have Been Restated Following

Issuance of the Predecessor’s Report and the Successor

Auditor Has Not Applied Sufficient Procedures to Satisfy

Himself as to the Appropriateness of the Restatement

Adjustments REPORTO05

Successor Auditor’s Unqualified Opinion When Prior-Year
Financial Statements Have Been Restated Following
Issuance of the Predecessor’s Report and the Successor
Auditor Has Applied Sufficient Procedures to Satisfy
Himself as to the Appropriateness of the Restatement

Adjustments REPORTO06
Auditor’s Unqualified Opinion—Opinion Based in Part
on Report of Another Auditor REPORTO07

Auditor’s Unqualified Opinion When There Is a Change
in Accounting Principles or in the Method of Their
Application That Has a Material Effect on the

Comparability of the Financial Statements REPORTO08
Auditor’s Unqualified Opinion Including an Explanatory
Paragraph Regarding a Litigation Uncertainty REPORT09
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